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TRADEMARK 
VEEMUX is a registered trademark of Network Technologies Inc in the U.S. and other countries.     
 
 

COPYRIGHT 
Copyright © 2009 by Network Technologies Inc.  All rights reserved.  No part of this publication may be reproduced, stored in a 
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without the prior written consent of Network Technologies Inc, 1275 Danner Drive, Aurora, Ohio 44202. 
 

CHANGES 
The material in this guide is for information only and is subject to change without notice.  Network Technologies Inc reserves the 
right to make changes in the product design without reservation and without notification to its users. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 ii        

 

 
TABLE OF CONTENTS 

 
 
Introduction...................................................................................................................................................................... 1 
Materials .......................................................................................................................................................................... 2 
Features and Functions................................................................................................................................................... 2 
Connect Cables............................................................................................................................................................... 4 
Operating the sm-4x4-dvi ................................................................................................................................................ 5 

Learn Mode.................................................................................................................................................................. 5 
Enter Learn Mode ..................................................................................................................................................... 5 

Change Connections Manually.................................................................................................................................... 5 
Operating the sm-8x8-dvi ................................................................................................................................................ 6 

Accessing the Setup Menu.......................................................................................................................................... 6 
Change Connections via RS232 ................................................................................................................................. 7 

Setup Control Computer ........................................................................................................................................... 7 
RS232 Protocol......................................................................................................................................................... 9 
Embedded Commands ............................................................................................................................................. 9 

Technical Specifications................................................................................................................................................ 11 
Warranty Information..................................................................................................................................................... 11 
 
 
 
 
 

TABLE OF FIGURES 
 
 
 
Figure 1- Connect devices and sources to VEEMUX ........................................................................................................................4 
Figure 2- Configure the VEEMUX connection....................................................................................................................................7 
Figure 3- Smart Control Connection Display......................................................................................................................................8 
 
 



NTI VEEMUX DVI VIDEO MATRIX SWITCH 

 1

 

INTRODUCTION 
The VEEMUX® 4x4 DVI video matrix switch (VEEMUX) provides non-blocking access to four single link digital DVI video sources 
from four displays. Locate computers up to 19 feet away from displays, enabling easy access to multiple servers in various 
locations.  
 
Also available: 
SM-8X8-DVI-  provides non-blocking access to 8 single link digital DVI video sources from 8 eight displays 
 
Features:  

• Configure and control the switch through serial port, or front panel buttons.  

• Supports DVI-D interface for crisp and clear video quality on flat panel displays.  

• Supports DVI operation at the maximum TMDS rate of 2 x 1.65 Gb/second 

• Silent fanless operation.  

• Provides high digital resolution up to 1920x1200 for monitors and 1080p for HDTV displays.  

• EDID learning for the support of any DVI display device.  

• Built in default EDID configuration tables for both PC and Mac.  

• Each output provides one video signal.  

• Each input can be independently connected to any or all outputs.  
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MATERIALS 
 
Materials supplied with this kit:  
• NTI SM-4X4-DVI or  SM-8X8-DVI   DVI Video Matrix Switch 
• 100-240VAC at 50 or 60Hz-5VDC/3.0A (4x4) or 4.0A (8x8) AC Adapter 
• CD containing pdf of this manual and control software 
 
Materials Not supplied but REQUIRED: 
 
 

• DVI-IS-xx-MM cable for each monitor and CPU being connected to the switch- available in 3, 6,10, and 15 foot lengths 
 
 
 

where:  
 xx is the length of the cable in feet 
           MM indicates male-to-male connector 
 
 

FEATURES AND FUNCTIONS 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
1.    Seven-segment Input LEDs- for indicating what inputs (video sources) are connected to the labeled output (display device)  
                                                        and Learn Mode indicator 
 
2.    Power LED- for indicating that power has been supplied to the unit 
 
3.    Output LEDs- for indicating which output is being configured when “Input Select” is pressed 
 
4.    Selection buttons- for manually changing connections between the inputs and outputs 
 
5.    OUTPUTx- female DVI connector- for connecting DVI cable from display device 
 
6.    INPUTx- female DVI connector- for connecting DVI cable from video source 
 
7.    RS232 connector- 9D male- for connecting the user's RS232 control cable 
 
8.    5VDC- power input connector for attachment of power supply 
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9.    LCD Display- for indicating which input is connected to which output 
 
10.    Scroll- used to and scroll though the LCD control menu options and enable the manual configuration setup 
 
11.    Enter-  used to select LCD control menu options and to select the output channel when changing connections manually 
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CONNECT CABLES  
 
1.  Connect a DVI male cable between each video source and an “Input” connector on the rear of the VEEMUX.  
 
2.  Connect a DVI male cable between each display device and an “Output” connector on the rear of the VEEMUX.  
 
3.  If the VEEMUX will be controlled using RS232, then connect a DB9 cable between the “RS232” port on the VEEMUX and a  
     serial port on a PC.  
 
4.  Connect the AC adapter to the VEEMUX and plug it in to power the VEEMUX ON. 
 
5.  Power ON the video sources and the display devices.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                         Figure 1- Connect devices and sources to VEEMUX
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OPERATING THE SM-4X4-DVI 

Learn Mode 
 
The VEEMUX is able to emulate a monitor for a connected video source, whether a monitor is actually connected or not.   To do 
this, the VEEMUX must first learn the specifications of a display device.   To make the VEEMUX learn the specifications, use 
“Learn Mode”.  
 

Enter Learn Mode 
 
 
1. Press and hold both front panel buttons simultaneously for 2 seconds.  
 
2. The letters L-E-R-N will appear on the Input LEDs.  
 
3. Pressing the “Input Select” button will scroll through each of three learning options, indicated by changing letters on the Input 
LEDs: 
 
              L-E-S =  learn the specifications of any monitor connected to “Output 1” 
              L-E-P =  use the built-in specifications of a PC monitor  
              L-E-A =  use the built-in specifications of an Apple monitor 
 
4. When the desired learning mode is displayed, press the “Output Select” button to execute the learning feature and return to 
normal operation.  
 
 

Change Connections Manually 
 
Two buttons are provided on the front of the VEEMUX for quickly making connections between video sources and display devices. 
To connect an Input (video source) to an Output (display device): 
 
1. Press the “Output Select” button until the desired Output LED illuminates. 
 
2. Press the “Input Select “ button to change the Input LED above the selected Output until the desired Input number is shown. 
 
3. Press the “Output Select” button again to change a different Output-to Input connection 
 
 
One video source can be set to display on all 4 display devices if so desired.  
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OPERATING THE SM-8X8-DVI 
 

Accessing the Setup Menu  
 
1. Simultaneously press and hold both front panel buttons for at least three (3) seconds, then release. 
 
2. The LCD should display:  

 
 
 
 
 
Where:    x.x is the version number, 
                <n> indicates the current setting: P=PC, M=MAC, S=SCREEN; 
                yy indicates the setting selection: PC, MAC, SCREEN. 
 
3. Use the front panel “Scroll” button to select the menu function. 
 

Setup Menu Functions 
 
For each function, press “Enter” button to select or press “Scroll” button to skip to the next function 
 
FUNCTION DESCRIPTION 
PC  Use the built in PC display DDC table. (factory default) 
MAC Use the built in MAC display DDC table. 
SCREEN Read, save, and use the DDC table from the display connected to Output 1 
Factory Reset,Y?  Press ”Enter” to restore factory settings 
Memory Recall, x? N= Use default matrix setting on power up 

Y= Use last configured matrix setting on power up 
(Press “Enter” button to toggle between Y or N, press “Scroll” button to 
select and go to the next function.) 

Exit Press  “Enter” button to exit the Setup Menu 
 
The Setup Menu will time out approximately 30 seconds after the last button press and return to normal mode.  

Change Connections Manually 
 
Two buttons are provided on the front of the VEEMUX for quickly making connections between video sources and display devices. 
To connect an Input (video source) to an Output (display device): 
 
1. Press and hold the “Scroll” button for a few seconds until the cursor starts blinking.  Release the Scroll button.   
 
2. Press the “Enter “ button until the desired Output channel is selected.   
 
3. Press the “Scroll” button until the desired Input channel is selected.  The change is immediate. 
 
The manual selection mode will timeout approximately 15 seconds after the last button press and the cursor will stop blinking.  
 
One video source can be set to display on all 8 display devices if so desired.  
 
 
 

SETUP MENU V: x.x 
DDC  <n>  :   yy  
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CHANGE CONNECTIONS VIA RS232 
 
Connections can be changed from a terminal located away from the VEEMUX, connected serially using RS232.   To change 
connections using the RS232 port, a control computer must first be setup.    
 

Setup Control Computer 
 
1.  Install the control software (found on the CD this manual is on) to a PC.  Browse the CD for the file 
 “veemux-dvi-control-vx-x-x_Installer.exe” and double-click it to install.  
 
2.  Connect a serial cable from the VEEMUX to the PC where the control software was just installed.   The default VEEMUX-DVI 
port setup is 9600bps, 8 data bits, no parity, 1 stop bit.  If the PC COM port is setup differently, you will need to change the PC 
COM port configuration (see table below).  
 

Com Port Settings: 

Baud Rate 9600 

Start Bits 1 

Data Bits 8 

Parity None 

Stop Bits 1 

 
3. Locate the “VEEMUX-DVI-Control” program in your programs list, and select it.  The following screen will be displayed.   
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                         Figure 2- Configure the VEEMUX-DVI-Control Software  
• Under “Router Count”, select the number of VEEMUXs to be controlled.  
 
• Under “Router Type”, select “DVI Matrix”.  Enter the correct number of Inputs and Outputs in their respective fields.  
 
• Under “Com Port”, select the Com Port that the RS232 cable is connected to. 
 
• Under “Comm Type”, select “Type B”.  
 
Note: To set this configuration as the default startup configuration, make sure the “Remember Config on Startup” check 
box is checked. 
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4. Click the “OK” button.  The following image (or one similar) will appear.  Blue dots will appear wherever the connections have 
been made between outputs (top row) and inputs (left column).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                               Figure 3- VEEMUX-DVI-Control Connection Display 
 
5. To change a connection, simply click on the point where the desired input intersects the desired output.   The blue dot will move 
accordingly and the connection change will be made.  
 
6. You can return to the Configure Router screen from the File pull-down menu. 
 
7. You can save and load configurations from the File pull-down menu.  
 
8. RS-232 error checking can be controlled from the Options pull-down menu (“CRC”).  CRC should be ON when using the 
VEEMUX-DVI-Control software. 
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RS232 Protocol 
 
Commands can alternatively be sent using a terminal emulator program that supports macros.  
The following section lists the available commands.  
 

Embedded Commands 
 
The VEEMUX can be controlled using connection commands embedded in serial programs.   Applicable RS232 commands are 
listed below: 
 
TABLE OF COMMANDS FOR SM-4X4-DVI 
Command:   ASCII HEX 
input_1_output_1 /    /   F   0   0  M   0   1   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 31 42 0D 
input_2_output_1 /    /   F   0   0  M   0   1   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 32 41 0D 
input_3_output_1 /    /   F   0   0  M   0   1   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 33 40 0D 
input_4_output_1 /    /   F   0   0  M   0   1   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 34 47 0D 
input_1_output_2 /    /   F   0   0  M   0   2   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 31 41 0D 
input_2_output_2 /    /   F   0   0  M   0   2   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 32 42 0D 
input_3_output_2 /    /   F   0   0  M   0   2   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 33 43 0D 
input_4_output_2 /    /   F   0   0  M   0   2   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 34 44 0D 
input_1_output_3 /    /   F   0   0  M   0   3   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 31 40 0D 
input_2_output_3 /    /   F   0   0  M   0   3   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 32 43 0D 
input_3_output_3 /    /   F   0   0  M   0   3   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 33 42 0D 
input_4_output_3 /    /   F   0   0  M   0   3   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 34 45 0D 
input_1_output_4 /    /   F   0   0  M   0   4   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 31 47 0D 
input_2_output_4 /    /   F   0   0  M   0   4   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 32 44 0D 
input_3_output_4 /    /   F   0   0  M   0   4   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 33 45 0D 
input_4_output_4 /    /   F   0   0  M   0   4   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 34 42 0D 
Query Current Matrix /    /   F   0   0  U   <CHK> <CR>   2F 2F 46 30 30 55 13 0D 
Input 1 – All Outputs /    /   F   0   0  M   0   0   I   0   1 <CHK> <CR> 2F 2F 46 30 30 4D 30 30 49 30 31 43 0D 
Input 2 – All Outputs /    /   F   0   0  M   0   0   I   0   2 <CHK> <CR> 2F 2F 46 30 30 4D 30 30 49 30 32 40 0D 
Input 3 – All Outputs /    /   F   0   0  M   0   0   I   0   3 <CHK> <CR> 2F 2F 46 30 30 4D 30 30 49 30 33 41 0D 
Input 4 – All Outputs /    /   F   0   0  M   0   0   I   0   4 <CHK> <CR> 2F 2F 46 30 30 4D 30 30 49 30 34 46 0D 
 
 
TABLE OF COMMANDS FOR SM-8X8-DVI 
Command:   ASCII HEX 
input_1_output_1 /    /   F   0   0  M   0   1   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 31 42 0D 
input_2_output_1 /    /   F   0   0  M   0   1   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 32 41 0D 
input_3_output_1 /    /   F   0   0  M   0   1   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 33 40 0D 
input_4_output_1 /    /   F   0   0  M   0   1   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 34 47 0D 
input_5_output_1 /    /   F   0   0  M   0   1   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 35 46 0D 
input_6_output_1 /    /   F   0   0  M   0   1   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 36 45 0D 
input_7_output_1 /    /   F   0   0  M   0   1   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 37 44 0D 
input_8_output_1 /    /   F   0   0  M   0   1   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 31 49 30 38 4B 0D 
input_1_output_2 /    /   F   0   0  M   0   2   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 31 41 0D 
input_2_output_2 /    /   F   0   0  M   0   2   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 32 42 0D 
input_3_output_2 /    /   F   0   0  M   0   2   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 33 43 0D 
input_4_output_2 /    /   F   0   0  M   0   2   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 34 44 0D 
input_5_output_2 /    /   F   0   0  M   0   2   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 35 45 0D 
input_6_output_2 /    /   F   0   0  M   0   2   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 36 46 0D 
input_7_output_2 /    /   F   0   0  M   0   2   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 37 47 0D 
input_8_output_2 /    /   F   0   0  M   0   2   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 32 49 30 38 48 0D 
input_1_output_3 /    /   F   0   0  M   0   3   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 31 40 0D 
input_2_output_3 /    /   F   0   0  M   0   3   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 32 43 0D 
input_3_output_3 /    /   F   0   0  M   0   3   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 33 42 0D 
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TABLE OF COMMANDS FOR SM-8X8-DVI (Continued) 
Command:   ASCII HEX 
input_4_output_3 /    /   F   0   0  M   0   3   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 34 45 0D 
input_5_output_3 /    /   F   0   0  M   0   3   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 35 44 0D 
input_6_output_3 /    /   F   0   0  M   0   3   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 36 47 0D 
input_7_output_3 /    /   F   0   0  M   0   3   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 37 46 0D 
input_8_output_3 /    /   F   0   0  M   0   3   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 33 49 30 38 49 0D 
input_1_output_4 /    /   F   0   0  M   0   4   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 31 47 0D 
input_2_output_4 /    /   F   0   0  M   0   4   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 32 44 0D 
input_3_output_4 /    /   F   0   0  M   0   4   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 33 45 0D 
input_4_output_4 /    /   F   0   0  M   0   4   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 34 42 0D 
input_5_output_4 /    /   F   0   0  M   0   4   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 35 43 0D 
input_6_output_4 /    /   F   0   0  M   0   4   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 36 40 0D 
input_7_output_4 /    /   F   0   0  M   0   4   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 37 41 0D 
input_8_output_4 /    /   F   0   0  M   0   4   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 34 49 30 38 4E 0D 
input_1_output_5 /    /   F   0   0  M   0   5   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 31 46 0D 
input_2_output_5 /    /   F   0   0  M   0   5   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 32 45 0D 
input_3_output_5 /    /   F   0   0  M   0   5   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 33 44 0D 
input_4_output_5 /    /   F   0   0  M   0   5   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 34 43 0D 
input_5_output_5 /    /   F   0   0  M   0   5   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 35 42 0D 
input_6_output_5 /    /   F   0   0  M   0   5   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 36 41 0D 
input_7_output_5 /    /   F   0   0  M   0   5   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 37 40 0D 
input_8_output_5 /    /   F   0   0  M   0   5   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 35 49 30 38 4F 0D 
input_1_output_6 /    /   F   0   0  M   0   6   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 31 45 0D 
input_2_output_6 /    /   F   0   0  M   0   6   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 32 46 0D 
input_3_output_6 /    /   F   0   0  M   0   6   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 33 47 0D 
input_4_output_6 /    /   F   0   0  M   0   6   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 34 40 0D 
input_5_output_6 /    /   F   0   0  M   0   6   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 35 41 0D 
input_6_output_6 /    /   F   0   0  M   0   6   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 36 42 0D 
input_7_output_6 /    /   F   0   0  M   0   6   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 37 43 0D 
input_8_output_6 /    /   F   0   0  M   0   6   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 36 49 30 38 4F 0D 
input_1_output_7 /    /   F   0   0  M   0   7   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 31 44 0D 
input_2_output_7 /    /   F   0   0  M   0   7   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 32 47 0D 
input_3_output_7 /    /   F   0   0  M   0   7   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 33 46 0D 
input_4_output_7 /    /   F   0   0  M   0   7   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 34 41 0D 
input_5_output_7 /    /   F   0   0  M   0   7   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 35 40 0D 
input_6_output_7 /    /   F   0   0  M   0   7   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 36 43 0D 
input_7_output_7 /    /   F   0   0  M   0   7   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 37 42 0D 
input_8_output_7 /    /   F   0   0  M   0   7   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 37 49 30 38 40 0D 
input_1_output_8 /    /   F   0   0  M   0   8   I   0   1 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 31 4B 0D 
input_2_output_8 /    /   F   0   0  M   0   8   I   0   2 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 32 48 0D 
input_3_output_8 /    /   F   0   0  M   0   8   I   0   3 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 33 49 0D 
input_4_output_8 /    /   F   0   0  M   0   8   I   0   4 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 34 4E 0D 
input_5_output_8 /    /   F   0   0  M   0   8   I   0   5 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 35 4F 0D 
input_6_output_8 /    /   F   0   0  M   0   8   I   0   6 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 36 4C 0D 
input_7_output_8 /    /   F   0   0  M   0   8   I   0   7 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 37 4D 0D 
input_8_output_8 /    /   F   0   0  M   0   8   I   0   8 <CHK> <CR>  2F 2F 46 30 30 4D 30 38 49 30 38 42 0D 
Query Current Matrix /    /   F   0   0  U   <CHK> <CR>   2F 2F 46 30 30 55 13 0D 
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TECHNICAL SPECIFICATIONS 
Video  

Video Amplifier Bandwidth 165MHz 

Input Video Signal 1.2 volts p-p 

Input DDC Signal 5 volts p-p (TTL) 

Single Link Range 1080p/1920 x 1200 

DVI Connector DVI-I 29 pin female 

Control  

Serial Controls RS232, DB9 female connector 

Power  

Power Supply-4X4               100- 240VAC at 50 or 60Hz-5VDC/3.0A AC Adapter 

Power Supply-8X8               100- 240VAC at 50 or 60Hz-5VDC/4.0A AC Adapter 

Physical  

Dimensions  WxDxH (In.) 

    SM-4X4-DVI 
    SM-8X8-DVI 

 
 
12x6.5x1.75  
17x7x1.75 

Weight                   4x4 

                              8x8 

4.1 lbs 

2.5 lbs 
 
 
 
 
 
 

Serial Cable DB9 Pin Connections 
At VEEMUX 
    (DCE) 

Signal 
Direction 

At PC 
(DTE) 

2  2 
3  3 
5        ------ 5 

 
 
 
 
 

WARRANTY INFORMATION 
 
The warranty period on this product (parts and labor) is two (2) years from the date of purchase.  Please contact Network 
Technologies Inc at (800) 742-8324  (800-RGB-TECH) or (330) 562-7070 or visit our website at http://www.networktechinc.com 
for information regarding repairs and/or returns.  A return authorization number is required for all repairs/returns. 
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Mating face of a DB9 female
RS232 Connector at VEEMUX

GRD VEEMUX
Send

VEEMUX
Receive

(remaining pins
  not used)


